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Limited Lifetime Warranty  
 
Miller Performance Ltd. warrants that products manufactured by Miller Performance Ltd will be free from 

defects in materials and workmanship for the life that you own your vehicle. If any such product proves 

defective during the applicable warranty period, Miller Performance Ltd., at its option, either will repair the defective 

product with charge for parts and labor or will provide a replacement in exchange for the defective product. Items 

not manufactured by Miller Performance Ltd. have a limited warranty of one year past the date of purchase. 

In order to obtain service under this warranty, the customer must notify Miller Performance Ltd. of the defect before 

the expiration of the warranty period and make suitable arrangements for the performance of service.  In all cases the 

customer will be responsible for packaging and shipping the defective product back to the service center specified by 

Miller Performance Ltd., with shipping charges prepaid. Miller Performance Ltd. shall pay for the return of the product 

to the customer if the shipment is within North America, otherwise the customer shall be responsible for all shipping 

charges, insurance, duties and taxes, if the product is returned to any other location.  

This warranty shall not apply to any defect, failure or damage caused by improper use or failure to observe proper 

operating procedures per the product specification or operators manual or improper or inadequate maintenance and 

care. Miller Performance Ltd. shall not be obligated to furnish service under this warranty 1) to repair damage resulting 

from attempts by personnel other than Miller Performance Ltd’s. representatives to repair or service the product; 2) to 

repair damage resulting from improper use or connection to incompatible equipment; 3) to repair damage resulting 

from operation outside of the operating or environmental specifications of the product.  

MILLER PERFORMANCE LTD. LIABILITY FOR THE MERCHANTABILITY AND USE OF THE PRODUCT IS 

EXPRESSLY LIMITED TO ITS WARRANTY SET OUT ABOVE. THIS DISCLAIMER AND LIMITED 

WARRANTY IS EXPRESSLY IN LIEU OF ANY AND ALL REPRESENTATIONS AND WARRANTIES 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 

MERCHANTABILITY OR OF FITNESS FOR PARTICULAR PURPOSE, WHETHER ARISING FROM 

STATUTE, COMMON LAW, CUSTOM OR OTHERWISE.  THE REMEDY SET FORTH IN THIS DISCLAIMER 

AND LIMITED WARRANTY SHALL BE THE EXCLUSIVE REMEDIES AVAILABLE TO ANY PERSON. 

MILLER PERFORMANCE LTD. SHALL NOT BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, 

INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THIS PRODUCT OR 

CAUSED BY THE DEFECT, FAILURE OR MALFUNCTION OF THIS PRODUCT, NOR ANY OTHER LOSSES 

OR INJURIES, WHETHER A CLAIM FOR SUCH DAMAGES, LOSSES OR INJURIES IS BASED UPON 

WARRANTY, CONTRACT, NEGLIGENCE, OR OTHERWISE.  BY ACCEPTING DELIVERY OF THIS 

PRODUCT, THE PURCHASER EXPRESSLY WAIVES ALL OTHER SUCH POSSIBLE WARRANTIES, 

LIABILITIES AND REMEDIES. MILLER PERFORMANCE LTD. AND PURCHASER EXPRESSLY AGREE 

THAT THE SALE HEREUNDER IS FOR COMMERCIAL OR INDUSTRIAL USE ONLY AND NOT FOR 

CONSUMER USES AS DEFINED BY THE MAGNUSOM-MOSS WARRANTY ACT OR SIMILAR STATE 

CONSUMER WARRANTY STATUTE 
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W.A.R. Chip Disclaimer 
 

 

THIS IS A HIGH PERFORMANCE PRODUCT.  USE AT YOUR OWN RISK. 

 
Do not use this product until you have carefully read the following agreement. 

 

This sets forth the terms and conditions for the use of this product.  The installation of this product 

indicates that the BUYER has read and understands this agreement and accepts its terms and conditions. 

 

DISCLAIMER OF LIABILITY 

 
Miller Performance Ltd. and its distributors, jobbers, and dealers (hereafter SELLER) shall in no way be responsible 

for the product's proper use and service.  THE BUYER HEREBY WAIVES ALL LIABILITY CLAIMS. 

 

The BUYER acknowledges that he/she is not relying on the SELLER's skill or judgment to select or furnish tunes 

suitable for any particular purpose and that there are no liabilities which extend beyond the description on the face 

hereof and the BUYER hereby waives all remedies or liabilities, expressed or implied, arising by law or otherwise, 

(including without any obligations of the SELLER with respect to fitness, merchantability and consequential damages) 

or whether or not occasioned by the SELLER's negligence. 

 

The BUYER is responsible to fully understand the capability and limitations of his/her vehicle according to 

manufacturer specifications and agrees to hold the SELLER harmless from any damage resulting from failure to adhere 

to such specifications. 

 

The SELLER disclaims any warranty and expressly disclaims any liability for personal injury or damages.  The 

BUYER acknowledges and agrees that the disclaimer of any liability for personal injury is a material term for this 

agreement and the BUYER agrees to indemnify the SELLER and to hold the SELLER harmless from any claim related 

to the item of the equipment purchased.  Under no circumstances will the SELLER be liable for any damages or 

expenses by reason of use or sale of any such equipment. 

 

The BUYER is responsible to obey all applicable federal, state/provincial and local laws, statutes, and ordinances when 

operating his/her vehicle, and the BUYER agrees to hold SELLER harmless from any violation thereof. 

 

The SELLER assumes no liability regarding the improper installation or misapplication of its products.  It is the 

installer's responsibility to check for proper installation and if in doubt, contact the manufacturer. 
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1. General Information 

1.1 Introduction 
 

Congratulations on purchasing your Miller W.A.R. Chip. You have joined the 

performance chip revolution and you are taking power of your car. 

 

W.A.R. stands for “Write and Remap” and is a revolutionary performance chip for 

European cars up to 1996. It is the most powerful performance chip money can buy, 

rendering traditional aftermarket chips obsolete. The W.A.R. Chip is not your average 

chip because it has multiple functions. It can have up to four reprogrammable & user 

controllable tunes loaded onto it. It has a mini-USB port on the side of the circuit board 

so you can load different performance files from your laptop to your W.A.R. Chip. The 

Miller W.A.R. Chip even comes with software for your Windows
™

 based laptop to let 

you modify your tunes whenever you want! 

 

You will soon ask yourself why a product like this took so long to come to market! 

1.2 W.A.R. Gear 
 

The Miller W.A.R. Chip features the following: 

 
Figure 1 
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1.3 Gear Included 
 

Standard Issue: 

 

 W.A.R. Chip 

 USB Cable 

 Tune Command Module (TCM) 

 Instruction Manual (Downloaded) 

 W.A.R. Software for Windows (Preloaded on WAR Chip) 

1.4 Tools Required 
 

The Following tools and supplies (not included) or similar tools and supplies are required 

for fast and proper installation of this Miller Performance product: 

 

Minimum requirements: 

 

- Flathead Screwdriver 

- Philips Screwdriver 

- 10mm socket wrench 

- 13mm Wrench 

- Drill 

- Metric Allen Set (with 1.5mm Allen) 

- Loctite 

 

1.5 Computer Software 
 

System requirements: 

 

- Windows Based Computer with Windows XP 

- Latest Version of Java Runtime Environment (Free at www.Java.com) 

- Internet connection 

- USB 1.0 or 2.0 
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1.6 Safety and Precautions 
 

 

Warning: 

Ensure vehicle cannot roll when working on the vehicle 

 

Warning: 

Disconnect the ground strap (negative) whenever doing work on 

electrical or fuel systems. 

 

Warning: 

Never run the engine unless the work area is well ventilated. Carbon 

monoxide kills! 

 

Caution: 

Before starting each procedure, ensure that you have all the necessary 

tools and parts on hand. Read all instructions thoroughly; do not 

attempt shortcuts use only parts and materials that are included in this 

kit or approved by Miller Performance. 

 

Caution: 

Miller Performance does not recommend “street tuning.” The safest 

place to tune your car is on a chassis dynamometer. 
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2. W.A.R. Chip Software 

2.1 Introduction 
 

The W.A.R. Chip software for Windows is where all the tuning, should you wish to tune 

your car, takes place; as well as the file uploading/downloading from remote tuning 

assistance. The W.A.R. Software is a powerful tool giving you total access to many 

features in the ECU such as control of your fuel and ignition, RPM limit, idle speed etc. 

This section is going to explain installation and use of the software. 

2.2 Installation 
 

The W.A.R. Chip comes preloaded with the W.A.R. Chip Setup Wizard. The first time 

you plug your W.A.R. Chip into the computer it will run the Wizard. Make sure you have 

a valid internet connection, as well as the latest JAVA installed on your computer. JAVA 

can be downloaded for free at www.java.com. 

 

You must meet the above requirements or the Wizard will not run. 

 

1. Plug the W.A.R. Chip into your computer and wait for a window to pop up 

asking if want to run the Wizard. 

 

2. Follow the installation procedure. 

 

a. Choose your ECU type 

 

b. Choose your base files (all four fields must have a file in them) 

 

c. Enter information as requested, and software will install 

 

d. Choose to upload files to the W.A.R. Chip now. 

 

3. Once installed, run the W.A.R. Chip program if it doesn’t not do so 

automatically and it will upload your tunes you chose in the wizard. This 

process may take a few minutes. 

 

 

NOTE: A video is available on our website to walk you 

through the Wizard.  

http://www.java.com/
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Manually adding  .ECU configuration files 
 

You may add additional .ECU Configuration plug-ins for tuning different ECU types 

from the same software. To manually upload a new .ECU Configuration file: 

 

 

1. Click Tools in the top menu bar and then click “Add ECU Type” or quick key 

“CTRL A” You will be prompted with the screen bellow asking for the .ECU 

File. 

 

 
 

2. Select your .ECU configuration file and click, “Open” You may or may not 

be prompted for an Access Code to unlock the .ECU file. 

 

 

 
 

3. Email us your request code, and your unique access code will be emailed back 

to unlock your new plug-in. 
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2.3 Using the W.A.R. Chip Software 
 

Once you have gotten started and you wish to use the software you will need to know 

how things work. Let’s focus on the layout. 

 
Figure 2 

Focusing on the menu and tab functions  
 

To get started, we will focus on the top menu bar where File, Edit, Tools & Help are 

located. This is the standard menu bar that nearly all windows programs have.  

 

Looking below the top menu, you will see the W.A.R. Tune module. The yellow bar 

appears over the active tune you are viewing. 

 
This tab layer allows you to view your tunes you can open new tunes into different 

modules, or read the associated tune from the W.A.R. Chip. They are labeled map 1, 2, 3 

& Default. Also you will see the control up and down arrows. These arrows are used to 

adjust your values of your specific map’s tables. 
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You can rename the tune modules. This will allow the WAR Chip to remember the tune 

name for easy reference in the future. To rename a tune’s tab, double click on it and 

rename it. 

 

 

 
In each Tune’s module, you will find the various maps you are able to edit. Again, the 

active map is displayed with a yellow bar above the name. Depending on your ECU type, 

you may have many more features to edit than this example. Here you can adjust the 

values of the given data tables under a selected Tune module. You can choose which 

table you want to edit by clicking on PT (Part Throttle) Ignition, PT fuel, WOT (Wide 

Open Throttle) fuel and so on. 

 

 

2.4 Reading From the W.A.R. Chip 
 

To load your tune into the W.A.R. Software from the W.A.R. Chip you simply go, “File 

> READ. This will allow you to read the Map Module for the current tab you are working 

in. You can also use the appropriate shortcut key Ctrl+D. 

 

 
Figure 3 
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Once you have downloaded your data from the W.A.R. Chip to your computer you 

should see something like the following: 

 

 
Figure 4 

 

2.5 Writing to the W.A.R. Chip 
 

Once you have made changes to your software and wish to write the revised tune to your 

W.A.R. Chip save your project first. You don’t want to lose all the work you have done. 

Simply click, File > Save As. Once you have saved your file, you can go ahead and write 

it by clicking, File > Write. 

 

The writing process takes about a minute to complete. During this time, DO NOT 

REMOVE THE USB CABLE. 

 

 
 

For even more information and detailed instructions check out our video section online, it 

has loads of “How To” videos for the W.A.R. Chip.  
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3. Installation 

3.1 Introduction 
 

The following section provides information that MUST be read and understood before 

proceeding with the installation of your Miller W.A.R Chip The information included in 

this section is considered basic essential information and may not include any or all 

possible complications you may experience during the installation of this system.  

 

Limit the number of distractions while installing this product. Pay close and careful 

attention to the instructions and information provided in this manual during the 

installation. Damage to your vehicle and/or personal injury may result due to lack of 

attention. 

 

3.2 Battery Disconnect 
 

 
Figure 5 

Disconnect the Negative terminal on the battery. 
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3.3 ECU Removal 
 

This section will guide you through the process of accessing your ECU to replace your 

current chip with the W.A.R. Chip. There are three possible locations for the ECU. If you 

don’t have any signs of an engine bay ECU location its probably in the glove box. 

 

Glove Box Location: 

 
1. Open the glove box and remove plastic cover to expose the 

ECU located on the top of the glove box compartment. 

 

  2.   Now the ECU will be exposed. Using a 10mm socket 

  Wrench, undo the two 10mm nuts. 

 

  3.   Unplug the ECU from its connector harness. 

 

E-box Location: 

 
 

1. Open the hood and access the ECU in the E-box on the 

passenger side of the engine bay (Upper Side). Using a 

Philips screwdriver undo the four screws. 

 

 2.   ECU is closest module to firewall. Using a 10mm socket, 

  undo the two 10mm nuts or pull the locking clips. 

 

     3.   Unplug the ECU from its connector harness. 

 

Firewall Location:  

 
 

1. Open the hood and access the ECU in the firewall 

compartment on the passenger side of the engine bay 

(Upper Side). Using a Philips screwdriver undo the Three 

screws. 

 

 2.   Now the ECU will be exposed. Using a 10mm socket 

  Wrench, undo the two 10mm nuts. 

 

     3.   Unplug the ECU from its connector harness.  
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3.4 Chip Removal 
 

The Chip contains the software required for your vehicle to operate. Avoid high static 

areas. Also avoid dropping the chip or spilling liquids on it. 

 

You need to take the metal case off of the ECU. There are tabs all the way around the 

bottom side. There may also be small screws depending on your ECU model. Using a 

small flat screwdriver gently lift up the tabs to release the ECU. Be careful not to bend 

the tabs too far as they may break. 

 

Once you have the ECU open and the chip side exposed you are ready to replace your 

current chip. 

 

Carefully pry with a small flathead screwdriver evenly on each side of the chip back and 

forth until it is free from its holder. If you are not careful you may damage the pins on the 

Chip.  

 

 
Figure 6 - Damaged Chip 

 

Take the W.A.R. Chip and install it in place of the original one. Make sure that you align 

the small notch (half circle) on the W.A.R. Chip, to the small notch on the ECU; this will 

insure your chip is installed properly. Do not reinstall the ECU cover just yet. 
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3.5 Your W.A.R. Chip’s Accessories 
 

USB Cable 
 

You are almost ready to reassemble the ECU and install it back in place. This is the point 

where you need to decide on how you want to access your W.A.R. Chip should you 

decide to tune your car. It is fine to install your W.A.R. Chip and drive or tune your car 

with the ECU cover off. Just make sure that you aren’t exposing the ECU to water. When 

you are done tuning you can remove the USB Cable and reinstall your ECU as normal. 

 

Or while you are making the slot for the TCM in the next step, you can make sure the 

opening is large enough to incorporate both the TCM and the USB Cables. The USB 

Cable can safely be permanently plugged into the W.A.R. Chip. When not in use, you can 

wind the USB cable up and tuck it in beside the ECU in its appropriate compartment. 

 

 

NOTE: You cannot start the car with the W.A.R. Chip plugged into your laptop. 

Simply unplug the USB cable from your laptop’s USB port. 

 

Tune Command Module (TCM) 
 

The TCM is the module that allows you to select between the 4 different tunes you have 

saved on your W.A.R. Chip. The TCM is meant to be installed permanently. Because the 

TCM controls the W.A.R. Chip from the cabin, it is meant to be installed with the 

W.A.R. Chip in the ECU. 

 

There are a number of locations you can mount the TCM itself. You can mount it on the 

driver’s side under the dash, in the glove box, in an accessory button position on the dash, 

or even in the engine bay. Because there are so many locations to mount the TCM, we 

can’t instruct every outcome. For idea’s you can always visit our online forum.  

 

Once you have successfully mounted your TCM you need to plug it into the TCM port on 

your W.A.R. Chip. In order to switch between your 4 tunes the TCM must be plugged in 

at all times. In order to have your TCM plugged in while the ECU is installed in its 

proper location you will have to modify your aluminum ECU cover. 

 

You can safely cut a small notch in the side of the ECU cover to allow the TCM to exit 

the ECU without fear of pinching the cable. Because the ECU is in an enclosed 

environment, you don’t have to worry about water getting into your ECU. 
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Installation 
 

1. The TCM knob has 5 wires going to it. One wire is loose on purpose. This is for 

your optional Anti-theft device integration. 

 

2. To mount the TCM, you must first remove the dial. Using the 1.5mm Allen 

wrench, undo the set screw on the side of the knob. 

 

3. Once you have removed the knob, you must undo the nut on the TCM module and 

remove it along with the lock washer. Drill a hole in the location you want to 

mount the TCM. 

 

4. You will notice a small ring left on the TCM, this is the position lock. Depending 

on where you set the lock, will determine how many “clicks” or positions you will 

have. Position 1 is all the way counter-clockwise. Make sure that the lock is set so 

that you have 4 positions available. You will have 3 “clicks” 

 

5. Mount the TCM through the hole with the lock set in place, and secure the TCM 

with the nut that you removed. You can now reinstall the TCM knob. Below is a 

picture of the TCM unit. 

 

 
Figure 7 

Once you are satisfied with your W.A.R. Chip’s accessories, you can re assemble your 

ECU and start driving your car. Before you permanently reinstall your ECU, hook up 

your battery and start your car to make sure there are no problems. If you have a problem, 

please refer to the troubleshooting guide in section 5.  
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4. W.A.R. Software and Tuning 

4.1 Introduction 
 

This section is a BREIF description of tuning theory to help guide you through the 

absolute basics. It is advised that you educate yourself further if you don’t feel 

comfortable with the following basic descriptions. If you have any questions, please use 

our online forum. 

 

Miller Performance is not responsible for your engine. Tuning your car is done at 

your own risk. 

4.2 Understanding Ignition 
 

With the W.A.R. Chip Software, you can control your vehicles actual timing. Like back 

in the day, you can advance and retard ignition timing. However, you don’t need all those 

tools and timing lights you once had to use. With the simple increase or decrease of a 

value you can either advance or retard your timing. 

 

The following diagram will help explain timing and how it is measured. 

 

 
Figure 8 

Top Dead Center (TDC) - B 
 

In a reciprocating engine, the TDC is the position of a piston in which it is farthest 

from the crank. Top dead center is the datum point from which engine timing 

measurements are made. For example, ignition system timing is normally specified as 

degrees before top dead center (BTDC). 

 

Before Top Dead Center - A 
 

Ignition timing advance refers to the amount of degrees before TDC the ignition is 

triggered. The higher the ignition number the sooner the ignition is triggered and 

therefore the more advanced the timing is. 
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Every engine is different, but there is a preferred range of timing that produces the 

most amount of power. And theoretically, the more advance you can run, the more 

power you will make. Too much timing advance can cause pre-detonation otherwise 

known as pinging. This is when the fuel mixture ignites before, or at, TDC which as 

you can see by the above illustration works against the rotational direction of the 

engine. Too much pre-detonation can be catastrophic. 

After Top Dead Center – C 
 

ATDC is when the fuel mixture actually ignites and provides power. The more 

advance you can run, the sooner ATDC your mixture will actually ignite giving 

you more power during the ignition stroke. 

 

This section was meant to give a basic explanation of ignition timing. If you want to learn 

more, there are plenty of document online explaining in detail, the ignition process. 

 

4.3 Understanding Fuel 
 

The W.A.R. Chip software give you control of your engines fuel injection as well. Like 

ignition there are some key principals one should understand to effectively tune their own 

vehicle. 

 

Air Fuel Ratio (AFR) is the mass ratio of air to fuel present during combustion. When all 

the fuel is combined with all the free oxygen, typically within a vehicle's combustion 

chamber, the mixture is chemically balanced the AFR is called the stoichiometric mixture 

(often abbreviated to stoich) and appears as 14.7 on a wideband O2 sensor. 

 

Typically, on part throttle cruising; your vehicles O2 sensor will try to keep your fuel 

mixtures as close to 14.7:1 as possible. To help make your vehicle maintain its fuel 

efficiency, tuning of your part throttle ignition and fuel maps will help you bring the AFR 

closer to 14.7:1 

 

To run more timing, you typically need more fuel. Running too much timing with not 

enough fuel can lead to pre-detonation. 

 

On Wide open throttle, you typically want to see AFR’s in the mid to high 12’s (12.5:1 

AFR) if possible. Again, every engine is different, and you will learn where your vehicles 

AFR’s for part throttle and wide open throttle will need to be as you gain experience. 
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4.4 Ignition & Fuel Working Together 
 

The combination of the amount of fuel being injected and the timing of the ignition will 

help you achieve your desired AFR. Too lean of an AFR can be catastrophic to an engine. 

Too rich of a mixture can also ruin an engine but it is always safer to be on the rich side 

of the scale while base tuning. As you refine your tune, you can find the limits of how 

lean you can run to maximize the power output of your tune. 

 

4.5 Changing Table Values 
 

Once you are confident in your understanding of ignition and fuel, you can begin to tune 

your vehicle. Here is a screen shot of a part throttle timing map for a 173 ECU. 

 
Figure 9 

Changing the values is easy. You can select one cell at a time, or multiple cells. To select 

a cell, simply click the cell to highlight it. 

 

1) Typing Method: When typing a value, you can only change one cell at a time. 

 

2) Control buttons: In the software you will see two purple buttons. These can be 

used to increase or decrease the values. Beside the purple arrows, you will see an 

input box with a default value of 1. You can change that value to increase or 

decrease in larger increments. 

 

3) + & – Keys: You can also use the +/– keys on the key board. These keys will also 

follow the increment value set in the top right. 
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Ignition values:  
 

Ignition is displayed in the GUI as actual timing in degrees. If it says 14, you are running 

14 degrees of timing BTDC (advance). 

 

If it says -14, you are running 14 degrees of timing ATDC (extremely retarded timing) 

Fuel Values: 
 

The Fuel values displayed are the values the ECU uses. To reduce complexity and 

understanding the values are raw. They are not displayed in Lambda as it may confuse 

people. The Fuel values are basic. The higher the number, the more fuel you are 

injecting, the lower the value, the less fuel. 

RPM: 
 

The RPM value has been converted to show its real world value. The RPM of you engine 

should remain below 7000 RPM, unless you have a modified engine that can handle a 

higher RPM. 

 

Min and Max Values: 
 

Because of the ECU’s structure some values are limited in their range. The W.A.R. Chip 

software takes care of these values and will not let you enter something higher or lower 

than the ECU can possibly accept. If you are trying to exceed a value or one that is typed 

reverts to a different value, you are at this limit. 

 

It is rare to be at these extremes. If this happens to you, call us and we can help 

accomplish what you need done through different means in the software you may not 

have access to. 
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4.6 Write Your New Tune(s) 
 

Once you have modified your table values and want to try your change(s) out simply save 

your project(s). You must save each Map Set individually. 

 

Once you have saved your file(s) you can now write them to the W.A.R. Chip. Plug your 

W.A.R. Chip USB cable in if you haven’t already. The W.A.R. Chip will overwrite 

existing maps (map 1, 2, 3 & default) if you have data loaded into the corresponding 

maps in the windows software 

 

For example, if you are working with Map 1 and 2 and go to upload your work, Map 1 

and 2 will be overwritten on the W.A.R. Chip while map 3 and default will remain 

unchanged. 

 

To upload your work, “File > Write” It will ask if you are sure you want to upload your 

Data, click “Yes.” 

 

 
 

Do not unplug you W.A.R. Chip while the data is wirting. Once your write process 

completes, unplug the USB cable from your computer. Remember, you cannot start the 

car while the USB cable is plugged into your computer. 

 

If you are unsatisfied with your changes simply repeat the process described in section 

2.5, make your changes and upload your new data once again. There is no limit to the 

amount of times you can change your tune. 
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4.7 Special Features 
 

Set Your Default 
 

With the W.A.R. Chip for Windows software, you can set your default. This is very 

useful in the case that you want to revert back to the last working tune. 

 

Let’s say that you have a base tune that you have made that isn’t 100% perfect, but 

definitely something that you are proud of. You can set that as the default Map Set the 

W.A.R. Chip for windows software can always revert to with one click. This helps speed 

up the tuning process. 

 

To do this, you can press, “Alt+D” or go, “Tools > Set as default tune” One day you will 

experience the need for this option and you will be glad it’s there. 

 

Select & Add ECU Type 
 

This is another great feature. If you have more than one W.A.R. Chip, or, you use your 

W.A.R. Chip in more than one different car you will be able to use ONE software to edit 

your different ECU types. 

 

To Add another ECU after you initial installation you can click “CTRL+A” or you can 

go, “Tools > Add ECU Type” You will be prompted again to get a request code unique to 

your computer and .ECU file. After you enter your request code, W.A.R. Chip for 

Windows will close. 

 

To select between your .ECU Configuration files, you must go to, “Tools > Select ECU 

Type” Once you click on the desired ECU, W.A.R. For Windows will close and need to 

be re-opened.  
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5. Troubleshooting 

5.1 Possible problems 

Car doesn’t start 
 

If your car does not start make sure of the following: 

 Your W.A.R. Chip is installed in the correct orientation. 

 You have loaded the PROPER base files onto the software 

 Your W.A.R. Chip is properly seated in the ECU 

 Your USB cord is not plugged into the laptop 

 Your battery was reconnected 

 

If all of the above is determined to be ok, simply install the factory chip. If the car runs 

off the stock chip, contact Miller Performance. 

Check Engine Lights 
 

If you are getting a check engine light turn the vehicle off and follow these steps 

 Unplug the ECU for 30 seconds 

 Plug the ECU back in  

 Change the position of the TCM to access a different Map 

 Start the car 

 

If your Check engine light does not come back after three start cycles reload the 

problematic map. If all TCM settings produce a check engine light, please contact us. 

W.A.R. Chip not communicating 
 

If you are having trouble communicating with the W.A.R. Chip make sure of the 

following: 

 You are using a XP based computer 

 Your USB Cable is properly inserted in the W.A.R. Chip 

 Make sure your USB cable isn’t broken 

 Make sure your car isn’t running 
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5.2 Seeking Help 
 

If you cannot resolve any of the above problems check out our FAQ section on our 

website, or watch some of our tech support videos before calling.  

 

http://www.millerperformancecars.com/ 

 

The W.A.R. Chip is a useful automotive tool in many ways. One great way is its 

community building power. As the product grows and people gain experience we want to 

grow a solid, online reference community. If we start early the literature available for the 

W.A.R. Chip online will help further the product ease of use and help build the ultimate 

support network. 

 

 

NOTES 
 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

 

 

 

 

 

 
Published June 23, 2010 by, Brody Saari; Photos taken by: Brody Saari, Dan Miller. Copyright 2011 All rights reserved. Any 

unauthorized reproduction of this document or any part of, for use other than that of original owners’ application is prohibited. 

Miller Performance Ltd. 2006 

209KSHU09.3.ASD93.10 

http://www.millerperformancecars.com/

